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Como utilizar esta Guia Electronica

Esta Guia Electronica fue disefiada para ser leida con Adobe Reader, un programa
gratuito para todos los usuarios de computadoras Mac y Windows. Usted puede
bajar la ultima versién de Adobe Reader en http://get.adobe.com/reader. La

funcionalidad de la guia puede variar dependiendo de su dispositivo de lectura.

Ademas de leer sobre su salud, usted puede usar esta Guia para:

- Saltar a temas especificos. Haga click con su flecha indicadora (cursor) en el
titulo de cualquier seccidn para pasar inmediatamente a ese tema.

« Buscar por un tema especifico. En el mend, vaya a Edit>Find (Editar>Buscar).
Escriba la palabra clave para su busqueda, seguidamente dé en la tecla Intro
(0 Enter). Los resultados de la busqueda seran resaltados. Para continuar al
siguiente resultado, simplemente pulse en la tecla de Retorno (o Enter).

- Buscar informacidn sobre palabras poco comunes. Use el cursor para
sobresaltar la palabra de interés (por ejemplo, “diabetes”). En el Menu,
seleccione “Edit"y de alli, “Look Up"” diabetes. Su buscador de internet abrird y
le proveera mas informacion sobre esta palabra.

- Seguir la informacion sobre su salud. Los lugares donde entrar su
informacién aparecen en azul. Haga click en cualquiera de los renglones en
azul y comience a escribir. Utilice la tecla de tabulacién (Tab) para pasar al
proximo espacio, o la tecla Return, cuando haya terminado. No olvide de
guardar (Save) sus cambios antes de cerrar el documento.

;Inquieto por como mantener su informacién privada? Edite sus paramet-
ros de seguridad: En el menu, vaya a Edit>Protection>Security Settings.

- Tome nota de preguntas o inquietudes sobre lo que esté leyendo. En el
menu, vaya a View>Comment>Annotations. Elija la opcién “Sticky Note.” Haga
click donde le gustaria insertar la nota y comience a escribir.

- Aprender mas por medio de recursos del internet. Haga click en cualquier
direccion para abrir ese sitio web en su buscador.

« Escuche a la guia leer en voz alta. Primero, active esta funcién. En el menu,
vaya a View>Read Out Loud>Activate Read Out Loud. Luego, vaya al mismo
lugar en el menu para comenzar, pausar, o terminar lectura en voz alta
(Begin, Pause o End Reading Aloud).
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Estos temas de la Guia de salud para adolescentes
pueden ayudarte a mantenerte al tanto de todo lo que hay
que saber en este campo.

— Amigos y relaciones
— Ejercicio y comidas
— Salud mental

— Habitos saludables
— Tabaquismo

— Sexo y proteccion
— Alcohol y drogas

— Lista de recursos
— Numero de teléfono personal




eegMigos Y relaciones

a vida no siempre es facil. Siempre habra preocupaciones como
examenes, trabajo, amor, problemas familiares, violencia en el
vecindario, y muchas cosas mas. Pero cuando nos enfrentamos con
problemas, siempre ayuda saber que tenemos amigos cerca de
nosotros. Son como el pegamento que lo une todo. ¢Pero como se
encuentran los amigos adecuados?

amistad verdadera

claves para una




Pero los amigos pueden cambiar. A veces quieren probar cosas nuevas,
y puede ser que empiecen a tener menos cosas en comun. Podria
parecer que la persona que tanto conocias ha desaparecido. Si sientes
que es muy dificil ponerse de acuerdo, o si tus amigos hacen cosas que
no son de tu estilo o de tu agrado, comienza a expandir tu circulo de
amigos. Intenta hablar con gente que te interesaria conocer, visita
clubes comunitarios o de la escuela, toma clases de arte o de musica,
participa en equipos deportivos, u ofrécete como voluntario para
conocer gente que tiene los mismos gustos que tu. ;Qué més puedes
hacer para que tu mundo sea un lugar mejor?

Libera tus emociones:

Sé creativo:

Activate:

Dedicate tiempo a ti mismo:
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hablar con padres, adultos
y profesionales de la salud

Los adultos no siempre saben qué esperar de los adolescentes. Prueba
con estos consejos para mejorar la comunicacion:

e Sé honesto cuando se trata de tus sentimientos.
Tus padres o tutores pueden ser siempre un
apoyo y una fuente de conocimiento, pero no
saben lo que te esta pasando si no se los
cuentas.

¢ Si estas molesto (no te gustan tus horarios,
estas castigado), no tomes la defensiva de
inmediato. Si comienzas a gritar o a llorar, no
podras expresar los sentimientos que realmente
importan.

Todas las familias tienen malos momentos, peleas y enojos. Es un
problema cuando estas situaciones llevan a golpes, insultos o el uso de
armas. Eso se llama abuso. Si esto esta pasando, habla con un consejero
estudiantil.

4, : N
National Child Abuse
Hotline
(Linea internacional contra
el maltrato infantil) A

1-800-422-4453 /

=,



hacer las pases —
resolver conflictos

Cuando todo lo demas falla, te puedes sentir frustrado, enojado o a
punto de explotar. Esto es normal. Lo importante es coémo te comportas
cuando estas enojado. Una forma saludable de abordar este problema
es tranquilizandose. Cuando algo te enoja mucho, intenta parar,
tranquilizarte y pensar antes de hacer o decir algo de lo que te puedas
arrepentir. Di lo que te esta molestando y por qué te enoja. Sila
situacion involucra a otra a otra persona, escucha escucha atentamente
lo que te esta diciendo:

¢ Busca soluciones (mas alla de pelear y
evitar) para resolver el problema.

¢ Si no puedes resolverlo, busca ayuda.

¢ Si alguien quiere confrontarse contigo y
tienes miedo de que se transforme en
algo violento, aléjate.

violencia — f'.qu,eo
puedes hacer tue

violencia escolar:

> Comienza contigo mismo. Promete que no te sumaras a la violencia; eso incluye
acoso escolar, bromas, o esparcir rumores. Respeta a los demas y valora las
diferencias.

> No lleves una pistola o cualquier otro tipo de armas, incluidas navajas.

> Denuncia a cualquier persona que sepas que lleva un arma.




para citas seguras

Sal en grupos y encuéntrense en lugares publicos.
Sigue tus instintos con respecto a una persona.

Los celos extremos, las amenazas y el comportamiento
controlador pueden llevar a la violencia.

Deja claro lo que quieres y lo que no quieres; nunca des
mensajes confusos.

Intenta no depender de que tu cita pague los gastos o te
lleve a tu casa.

Evita el alcohol, las drogas y las fiestas donde estos fluyen
libremente.

Investiga sobre el abuso en citas para que sepas con qué
puedes encontrarte y cémo actuar. Algunos buenos sitios que
puedes visitar son loveisnotabuse.com, chooserespect.org, y
safeyouth.org.



http://www.loveisnotabuse.com
http://chooserespect.org
http://safeyouth.org

Debes saber que si te sientes presionado a hacer algo
que no deseas, es tu derecho:

W y sientes que es incomoda, extrana, tensa, o
, confia en tus instintos y terminala.
Puedes necesitar ayuda para terminar una relacion violenta. Habla
con alguien de confianza. También puedes llamar a la Linea

Nacional sobre la Violencia Doméstica al 1-800-799-SAFE
(7233).

Si las personas adultas en tu vida toleran la violencia en sus
relaciones, puede ser que necesites apoyo adicional para evitar las
relaciones violentas en tu propia vida.



seguridad en linea —
aq?:é puedes hacer a?

Puede ser que estés dando mucha
informacién sobre ti mismo en las redes
sociales. Hay personas que quieren
aprovecharse de nifios y adolescentes y
utilizan los detalles personales para
enganar a los propios escritores y hacerles
creer que los conocen; no seas una de
esas victimas.



http://www.netsmartz.org

,,como me veo? ”
¢como me siento®

medida que tu cuerpo cambia, también cambia como te ves a ti
mismo. La autoestima tiene que ver con cémo valoras la persona que
eres. Quiere a tu cuerpo sin importar la forma, el tamafo o el color.
Mantenlo saludable con habitos de buenas comidas y actividad fisica.

Ya sea por tu cuenta o con tus amigos, ¢en qué puede
favorecerte que hagas mas actividad fisica?
> Mantener tu apetito y tu peso bajo control.

> Sentirte mejor y tener mas energia.
> Ayudarte a ver tu cuerpo desde un punto de vista positivo.
> Ayudarte a sentirte menos aburrido o deprimido.

> Ayudarte a manejar el estrés.

+ Debes hacer actividad fisica 60 minutos
cada dia.

- Diviértete. Puedes caminar, correr, nadar,
andar en bicicleta o bailar. Los deportes
en equipo también son geniales.

* Realiza ejercicios para entrar en calor por
5-10 minutos antes de hacer ejercicio y
relajate cuando termines.

+ Aumenta gradualmente la actividad fisica.



comer en forma saludable

Presta at ion a qué, cuando y cuanta comida comes. Comienza
con los habitos saludables ahora y los tendras para el resto de tu
vida.

Desayuna para despertar a tu cuerpo y a tu mente.
Evita las comidas con grasas y los dulces.

Respeta los tamafos de raciones regulares —
ino agrandes tus comidas!

Come cuando tengas hambre, no cuando estés aburrido.
Elige comidas bajas en grasas saturadas y trans, colesterol y sal.

Merienda frutas y vegetales, busca los vegetales de color verde
oscuro, rojos y naranjas. Intenta hacer 5 comidas al dia.

Los refrescos, jugos y bebidas deportivas tienen mucha azucar.

Si comes mientras miras television, probablemente comas mas de lo que
quieres.

Obtén calcio para tener huesos fuertes de la leche descremada,
yogures y quesos.

Elige panes y cereales integrales y con fibra.

Come pescado ya que es una fuente de proteinas, asi como la carne
magra, de ave, huevos y frutos secos sin sal.



Muchos adolescentes sufren de sobrepeso porque hacen poca actividad
fisica y debido a la forma en que ven la comida. La mejor forma de
evitar muchos problemas graves de salud es manteniendo un peso
normal. En lugar de hacer dietas, adopta patrones saludables de
alimentacién con comidas y colaciones. Mira rapidamente si tienes un
buen peso o si necesitas perder algunas libras:
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Saludable: 19-24
Con sobrepeso: 25-29
Obeso: 30+
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eeso|ud mental

trastornos de imagen corporal
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stas enfermedades de salud mental pueden llevar ¢
a problemas médicos peligrosos € incluso a la muerte.
Afortunadamente, hay tratamientos que pueden ayudar
a la gente a recuperarse por completo. Habla con un
proveedor de servicios médicos si experimentas algunos
de estos sintomas preocupantes. g ow

Los sii
- es;nt.o:nas Preocupantes de anorexia incluyen:

0 Intenso de aumentar d i .

‘ e pes i a
dt’eba-jo del peso correspondient':e. R per
Pérdida de Peso de al menos 2
Imagen de| Propio cuerpo dist,
gordo cuando no es asi).

R
ehusarse a Mmantener un peso saludable,

5 % del peso original.
orsionada (decir que estj

Los sintomas preocupantes de bulimia
(atracones y purgas) incluyen:
Habito frecuente de comer descontroladamente.

Forzarse a uno mismo a vomitar.

Tomar laxantes o diuréticos.
Excusarse para ir al bano justo después de comer.

Los sintomas preocupantes de trastorno por
atracon son:

Comer hasta el dolor.

Comer solo con frecuencia.

Acaparar comida.

Sentirse mal o disgustado con la cantidad de comida ingerida.



depresion —
témala en serio

Muchos adolescentes se sienten tristes o disgustados a

veces — especialmente bajo la presion de las relaciones, de
la familia y de los amigos. Si estas experimentando mas de un
sintoma de los detallados a continuacién, habla con alguien de
confianza, como tu papa o tu mama, un profesor, un
proveedor de servicios médicos o un miembro de tu
comunidad religiosa. Estos adultos pueden ayudarte a decidir
si necesitas ver a un profesional que pueda ayudarte a
encontrar soluciones para sentirte bien otra vez.

Sentirse triste a veces y tener cambios de humor es normal,
pero estar deprimido por mucho tiempo no lo es. Estos son
sintomas de depresion, especialmente cuando duran mas de
dos semanas:

Cambios en los habitos alimenticios y de sueio.

Tristeza que no se va.

Pérdida de interés en lo que solia ser divertido o interesante.

No salir mas con los amigos.

Pérdida de energia o motivacion.

Pensar en lastimarse o suicidarse.

Enojo y rabia.

Utilizar el alcohol o las drogas para “olvidarse” de los
problemas.

Reaccionar exageradamente frente a las criticas.

Falta de concentracién, olvido constante, o pesimismo
extremo.

Dolores y malestares que no mejoran con tratamiento.



Hablar sobre tus sentimientos muchas veces es el primer paso
para sentirte mejor. Lastimarte o suicidarte nunca es la solucion.
Si sientes que necesitas ayuda adicional, puedes recurrir a
tratamientos como terapia o medicamentos.

¢ Escuchaste alguna vez decir que la gente que habla de suicidio
no llega a hacerlo? Esto es un mito: la gente que habla de eso
puede intentarlo. Si tienes un amigo que habla sobre el suicidio,
no esperes a ver si él o ella se siente mejor.

¢ Qué pasa si tu amigo dice: “no le digas a nadie”? Debes decirle
que no puedes hacer eso. Escucha abiertamente y luego ayuda a
tu amigo a encontrar a una persona capacitada para tratar estas
situaciones. Si tu amigo tiene un plan detallado o parece querer

suicidarse y no quiere hablar, no lo dejes solo. Busca ayuda
inmediatamente.

)

Si estas pensando en lastimarte o

lastimar a alguien, busca ayuda ahora. Si

sientes que no puedes hablar con nadie,

llama a National Suicide Prevention

Lifeline (Linea Nacional de Prevencion del

Suicidio) al 1-800-273-8255. Siempre vas

a encontrar a alguien que quiere

escucharte y ayudarte. 0



Los sintomas preocupantes de suicidio incluyen:
Amenazas de suicidio.

Hablar sobre la muerte o sentirse indefenso y
desesperado.

Increible sensacion de culpa, vergiienza o critica.
Regalar cosas que valorabas.

Pensar en formas de suicidio y planificarlas.

Poemas, ensayos y dibujos relacionados con la muerte.
Cambio dramatico en la personalidad o la apariencia.
Cambio en los patrones alimenticios o de suefio.

Fuerte caida en el rendimiento escolar o laboral.

autolesion




eengphitos saludables

Ser adolescente significa desarrollar independencia. Informarte
sobre tu salud es parte de ello e incluye no faltar a las citas con el
médico, seguir sus consejos y tomar correctamente las medicinas.
Proteger tu salud es un proceso que te llevara toda la vida. {Sé la
persona que se ocupa de ello!

tomar el control —
visitar al médico

El proveedor de servicios médicos quiere verte
una vez al ano. Si sufres de alergias, asma o
diabetes probablemente debas ir al médico con
mas frecuencia. Si tu familia no tiene un seguro de
salud, puedes calificar para recibir un seguro del
estado. Pidele al proveedor de servicios médicos
que te ayuda a inscribirte.

Cuando vas al médico, probablemente estas

acostumbrado a que te hagan preguntas. Asegurate de
contestarlas honestamente, incluso si te sientes avergonzado. Tu
también puedes hacer preguntas sobre lo que desees. ¢ Tienes
preguntas sobre sexo y las ETS (enfermedades de transmision
sexual)? ;Cémo se hace un examen pélvico? ¢Con quién puedes
hablar sobre problemas familiares o con amigos? ¢ Puedes recibir
ayuda para dejar de fumar?

Los examenes fisicos son un buen momento para obtener
informacion. Aprende sobre medicinas, examenes o tratamientos
que puedas necesitar.




vacunaciones

Tétano, difteria,
tos ferina

Virus de papiloma
humano

Meningitis
meningocoécica

Hepatitis B

Virus de polio
inactivo

Sarampion, paperas,
rubeola

Varicela

Hepatitis A

Las vacunas te protegen de
enfermedades graves.




registro de examenes
y revisiones médicas

Peso / IMC
Odontologia

ol
e o5

pesV

Examen ocular

Presién arterial

Perfil de lipidos

{
pech®
“egu\‘”d%

pect®

ResY

dos



Anota la fecha y los resultados cuando te realices estos examenes. Consulta
con tu médico sobre recomendaciones especificas.

| al al al
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registro de examenes
y revisiones médicas

Examen de
la piel

Depresion

Enfermedades
de transmision
sexual (ETS)

Clamidia

Examen
testicular

Analisis
de orina

gect®

pest™®



Anota la fecha y los resultados cuando te realices estos examenes.
Consulta con tu médico sobre recomendaciones especificas.

| {
Fec‘“adog FeG:;:dos te
resV Re

gect?
pesW®

Beeu\\ados
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Proveedor de servicios meédicos/
odontoélogo/ consejeros

Nombre Teléfono




autoexémenes 0000000000000 0000O00

Cuando adoptes el habito de revisar tu cuerpo, estaras
preparado para contarle a tu proveedor de servicios médicos
acerca de cualquier bulto o cambio que encuentres.

Limita el tiempo que estas expuesto al sol (y el uso de las
camas de bronceado) para proteger tu piel y prevenir el
cancer de piel. Revisa los lunares de la piel e informa si
encuentras lunares nuevos o con cambios.

23
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[ D

uedes optar por proteger tu salud y no empezar a fumar en
ningun momento. Si fumas, es el momento de dejarlo. El uso de tabaco
mata a mas personas que el SIDA, los accidentes automovilisticos, el
alcohol, los suicidios, los homicidios, los incendios y el uso de drogas
ilicitas en su conjunto. Es la causa de muerte méas prevenible en los
Estados Unidos.

La nicotina, que se
encuentra en el tabaco, es
una droga de rapida accion
que afecta el sistema
nervioso y es muy adictiva.
Es la droga que se usa con
mayor frecuencia en el
pais. Algunos fumadores
afirman que se relajan al
usarla, en cambio otros se
tornan irritables y
nerviosos.

El tabaco sin humo (para “mascar” o “aspirar”’) no es mas seguro.
Algunas variedades tienen niveles mas altos de nicotina y son mas
adictivos. Usar este tipo de tabaco puede provocar cancer de boca, hara
que tu corazon lata mas rapido y aumentara tu presion arterial. Tiene un
alto contenido de azucar, lo que provoca caries. Algunos de los
resultados de “mascar” tabaco incluyen dientes flojos, recesién de las
encias, dientes manchados, regurgitacion, mal aliento y ulceras.



Los adolescentes que usan tabaco:

Tienen mayor riesgo de contraer cancer en el futuro, padecer
enfermedades pulmonares, problemas cardiacos y accidentes
cerebrovasculares.

Tienen mas dificultades para estar activos en los deportes debido a la
falta de aire.

Desarrollan dientes amarillos y tienen arrugas mas rapido.
Huelen mal —su cabello, ropa y aliento.

Gastan dinero en cigarrillos.

Hay gran cantidad de buenas razones para dejar este habito, pero es
dificil romper una adiccién. Estos consejos pueden ayudarte a dejarlo:

Fija una fecha y establece un plan para dejar de fumar y
siguelo.

Deshazte de recordatorios como ceniceros y
encendedores.

Lava o ventila los articulos que huelan a humo.
Deshazte de tus cigarrillos.

Prueba con la goma de mascar en lugar del tabaco “para
mascar”.

Aléjate del alcohol.
Mantente ocupado para no pensar en los cigarrillos.

Aléjate de los fumadores, al menos cuando estan fumando.

i las
A pesar del uso generalizado del tabaco en la TV, los videos Y

istas no lo
eliculas, la mayor parte de los adolescentes, ad:xltos y de?c:::ando ol
?:onsume’n De los adultos que consumen, el 90 % empezo

adolescentes y nunca penso que quedal jan atr apados. Las tabaca'elas
necesitan nuevos fumadores para leelnplazal a los mas de 1000 que
mueren por dia a causa de ellfelllledades |elaclonadas con el

tabaquismo — jno seas parte de la estadistica!

25



®eScXO Yy proteccion

na de las decisiones mas dificiles que enfrentan los
adolescentes es si tienen relaciones sexuales o no. También tienes
tiempo de esperar hasta que estés totalmente seguro. Si decides
esperar para tener relaciones, esta muy bien. Simplemente estds
analizando tus opciones antes de hacer algo para lo que quizas no
estas preparado. También te encuentras dentro de la mayoria —53 %
de los alumnos de escuela secundaria esperan para tener relaciones
sexuales.

Al margen de si decides tener relaciones o esperar, es bueno aprender
informacion sobre el sexo seguro y de qué manera el sexo afecta tu
salud. Si te encuentras en una relacién que se extiende hasta el punto
en el que estas listo para tener relaciones sexuales, debes conversar
sobre los métodos de proteccion para ti y tu pareja a fin de evitar
embarazos no planeados y enfermedades de transmisién sexual (ETS).
Si ya tienes relaciones sexuales, cuidate.

Puedes confiar en ti mismo para tomar buenas decisiones sobre
las relaciones y las barreras sexuales. Tienes derecho a:

. Cambiar de opinion.
. Decir “no” con conviccion.
. Decidir lo que crees correcto para ti.

. Alejarte de una situacion déonde hay mucha presion.

26



anticoncepcion

En términos simples, la anticoncepcion (control de la natalidad) es
responsabilidad de los dos integrantes de la pareja. Siempre que una
mujer tiene relaciones sexuales con un hombre existe el riesgo de
embarazo. El método de control de la natalidad mas efectivo es la
abstinencia (no tener relaciones sexuales). Para quienes tienen
relaciones sexuales, se encuentran disponibles numerosos métodos
anticonceptivos.

Los condones pueden ser un método efectivo para el control de la
natalidad. Usarlos correctamente, no obstante, significa algo mas que
ponérselo en la intensidad del momento. Asegurate de leer
detenidamente la hoja instructiva que viene con el preservativo. Y, aun
mas importante, usar uno en cada relaciéon sexual.

Otros métodos incluyen los preservativos femeninos, los diafragmas, los

capuchones cervicales, los métodos hormonales (pildoras, vacuna,
parche, anillo) y los DIU de larga accién e implantes. Estas opciones
requieren visitar a un proveedor de servicios médicos o clinica.

27
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fermedades de
::‘a:smisién sexual (ETS)

Cerca de 1 de cada 4 adolescentes sexualmente
activos se contagian una ETS. Estas infecciones por
lo general se transmiten de una persona a otra a
través de diferentes formas de contacto sexual, no
solamente en la relacion sexual. jDos tercios de las
personas con una ETS se contagian antes de los
25 anos! Si piensas que puedes “darte cuenta” si
una persona tiene una ETS, estas equivocado. Si
bien algunas infecciones presentan sintomas
visibles, muchas otras pueden estar en el cuerpo
durante afios sin evidenciar ningun sintoma.
Conversa con tu pareja para prevenir las ETS.

Puedes reducir tu riesgo de contraer una ETS.
:>I¢ Lleva siempre preservativos.
:>I<: Evita el sexo si estas alcoholizado.

:>I<: Niégate a hacer algo con lo que no te sientas
cémodo.

La mayoria de las ETS que se transmiten a través

de una relacion sexual también pueden transmitirse

por via oral. Recuerda: no todos los anticonceptivos

brindan proteccion contra las ETS y el SIDA. En

efecto, el uso de preservativos reduce el riesgo de ,
muchas ETS. La Unica manera de mantenerse

totalmente seguro de no contagiarse una ETS es

no tener sexo. Nunca es tarde para abstenerse de

tener sexo, incluso si ya lo has practicado.



es la ETS que se propaga con mayor rapidez. Si no se
trata, puede causar esterilidad (la imposibilidad de quedar
embarazada) y otros riesgos para la salud. Es importante
descartar su existencia ya que no es muy comun que se
presenten sintomas. Las mujeres sexualmente activas menores
de 24 afos deberian realizarse esta prueba. Si se detecta, es una
enfermedad tratable.

es una de las ETS mas comunes y curables. Es
causada por bacterias que viven en las partes hiumedas y
templadas del cuerpo; jpor eso, no pienses que el sexo oral no
tiene riesgos! Las personas que tienen esta infeccion
posiblemente no lo sepan. Pueden transmitirla a sus parejas sin
darse cuenta.

es causada por el virus del
papiloma humano (VPH). Muchas cepas de esta ETS comun
pueden infectar el area genital. Algunas pueden causar cancer de
cuello uterino, de ano y pene. Otras pueden causar verrugas
genitales. Se puede prevenir a través de la vacuna contra el VPH.

es una infeccion dolorosa causada por dos virus que
son faciles de contagiar. Puedes ser portador del virus, no
evidenciar sintomas y, aun asi, propagarla. El herpes es una
enfermedad que se puede tratar pero no se cura.

es una ETS peligrosa, incluso mortal, desarrollada por
bacterias. Se encuentra en ulceras o sarpullidos en la piel sin
dolor, en el interior de la boca o en la zona de los genitales. El
contacto con estas Ulceras también te infectara. La sifilis viaja por
la sangre y puede atacar tu corazon, cerebro o médula espinal.
Se puede curar en las primeras etapas, pero una vez que se
producen los dafos, no se puede revertir.




El virus de la inmunodeficiencia humana (VIH) causa
el sindrome de inmunodeficiencia adquirida (SIDA). Se transmite
mediante el intercambio de fluidos corporales infectados con VIH.
La infeccién se produce cuando el virus entra en la sangre. Tener
relaciones sexuales sin proteccion (sin preservativo) con una
persona infectada es la manera mas comun de contagiarse el
VIH. No existe una cura para el VIH/SIDA. La mejor manera de
combatir este virus es evitar contagiarselo.

es un virus que con frecuencia causa
infeccion y dafo hepatico cronicos. El virus de la hepatitis B se
propaga cuando la sangre y los fluidos corporales entran en
contacto con quiebres en la piel o en otras superficies del cuerpo.
Practicar sexo seguro (mediante el uso correcto del preservativo)
y evitar las agujas no esterilizadas ayudan a prevenir la
propagacion del virus de la hepatitis B. Si tienes pensado hacerte
un tatuaje o un piercing en el cuerpo, podrias infectarte si las
herramientas tienen sangre de otra persona. No compartas los
articulos personales que podrian tener sangre (navajas, cepillos
de dientes). Existe una vacuna contra el virus de la hepatitis B.

:>I¢ Si tienes una vida sexual activa, consulta con tu proveedor de servicios
médicos en forma periédica y sé honesto sobre tu experiencia sexual.
La unica manera de descubrir si tienes una ETS y de recibir tratamiento
es realizarte las pruebas correspondientes. Muchas clinicas y
departamentos de salud de los condados proporcionan tratamiento y
pruebas confidenciales sin cargo o a un costo minimo.
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eeocohol y drogas

eber es un mal habito para tu salud — jen serio! Afecta tu
cerebro, cuerpo y autocontrol — y también puede matarte. Las lesiones
matan a mas adolescentes que todas las enfermedades en conjunto y
la mayoria de estas se deben a accidentes automovilisticos. La mayor
parte de las colisiones fatales suceden por la noche, y el alcohol es
causante de muchas de estas muertes. Las posibilidades de sufrir una
muerte por inmersién también aumentan cuando bebes.

A pesar de lo que otros adolescentes puedan decirte, o de lo que veas
en laTVy en las peliculas, nunca esta bien beber y, con frecuencia,
hace que las personas actuen sin sentido. Puedes terminar sintiéndote
avergonzado, estresado y en un peor estado.

Para ayudar a prevenir un accidente automovilistico y
aumentar tus posibilidades de sobrevivir:

> Usa SIEMPRE el cinturon de seguridad. Gran parte de los
accidentes tienen lugar cerca de casa.

> Conductores, jpidanles a todos que

se abrochen el cinturén!
> Si has estado bebiendo o

consumiendo drogas, no conduzcas.
> No andes con alguien que ha \\

tomado o consumido drogas.
> Por cada pasajero del automovil, tus -

4
‘ “

probabilidades de sufrir un
accidente aumentan.

~
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Si el alcohol y/o el consumo de drogas podria ser un
problema real en tu vida, realiza esta prueba. Tilda las
casillas si:

Te emborrachas o drogas con regularidad.

Mientes (incluso a ti mismo) sobre la cantidad de drogas o alcohol
que consumes.

Piensas que necesitas beber o drogarte para estar relajado o
divertirte.

Hablas constantemente sobre las drogas o el alcohol.

Te sientes deprimido o tienes pensamientos suicidas.

Te olvidas de lo que dijiste cuando estabas ebrio o drogado.

Abandonas las cosas que solias hacer y dejas a los amigos que no
consumen drogas o alcohol.

Bebes o consumes drogas solo.

Te suspendieron de la escuela o perdiste el trabajo a causa del
alcohol o el consumo de drogas.

Te metes en problemas con la ley.

Estas en la ruina por las drogas.

Si tildaste una o mas de estas casillas o si sospechas de alguien que
conoces con estos problemas, pide ayuda de inmediato. Consulta la
Lista de recursos en las paginas 38-39.



Eres responsable de tu cuerpo y de cémo lo tratas. Las drogas pueden
arruinarte la vida. Es asi de simple. No te ayudaran a pensar mejor, a ser
mas popular, a pasar mejores momentos o a ser un mejor deportista. Si
tienes problemas, las drogas no los solucionaran. Estar drogado puede
hacerte olvidar cosas, por lo que te preocupas menos por ti mismo o tus
amigos. Si te sientes presionado para tener relaciones sexuales cuando no
es lo que quieres, las drogas hasta pueden dificultarte decir que no o
pueden llevarte a tener una relacién sexual poco segura.

Las drogas afectan tu cerebro, cuerpo y autocontrol. Muchas pueden
ser adictivas, son ilegales y pueden matarte, en especial, si se
combinan con alcohol.

Entonces, ¢cuales son las principales drogas?

Las sales de baiio (nutrientes para plantas,
incienso, “lvory Wave”, “Purple Wave”, “Vanilla
Sky”) son un polvo con dosis de quimicos que
actian como estimulante y alucinégeno.

La cocaina (coca, crack, porro, “Snow”, “Nose
Candy”, blanca, “Big C”) es muy adictiva. Consumir
cocaina puede hacerte sentir paranoico, enojado y
hostil, incluso cuando no estas drogado. Afecta tu
juicio. Incluso los que la consumen por primera vez
tienen convulsiones o ataques cardiacos.
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El éxtasis (entre sus nombres vulgares, “E”, “X”, “XTC”,
“Roll”) es en parte un estimulante y alucinégeno. Puede
alterar el estado de animo, la memoria y la manera de
pensar. El uso a largo plazo puede dafiar el higado, los
rifones, las habilidades motoras y la memoria.

El gamma-hidroxibutirato (GHB, por sus siglas en
inglés) (éxtasis liquido, “G”, “Georgia Home Boy”)
es la llamada droga “para la violacién en citas”.
Reduce la frecuencia cardiaca y respiratoria a niveles
peligrosos. Apenas el contenido de una tapa puede
provocar convulsiones y detener la respiracion. Las
sobredosis pueden ser fatales. Debido a que es un
liquido claro, se puede agregar a las bebidas sin que
lo sepas. Por lo tanto, ten cuidado de no dejar tus
bebidas al alcance de personas que puedan
administrar una dosis. Permite que solo las personas
en las que confias te traigan una bebida.

Los inhalantes (fijador de pelo, gasolina, pintura en
aerosol, pegamento) son sustancias toxicas. Aspirar
este tipo de sustancias puede conllevar dafo
cerebral e incluso la muerte.

La ketamina (también conocida como “K”, “K
especial”, “vitamina K”, “Cat Valium”, “Bump”)
causa pérdida de la memoria y ausencia de dolor. El
liquido se puede ocultar en bebidas, mientras que el
polvo se puede espolvorear en los cigarrillos o los
porros. Las sobredosis conducen a extrema
confusion y a la muerte.



El LSD (acido, “Blotter”, dosis, “Microdots”) es un
alucinégeno. Viene en frascos, cubos de azucar,
obleas de gel, pastillas o papel secante.

La marihuana (hierba, hachis, porro, canuto,
“maria”) afecta la memoria, el autocontrol, el juicio y
la salud. Un porro afecta los pulmones tanto como
cuatro cigarrillos.

Las metanfetaminas (speed, hielo, tiza, meta,
cristal, crank, fuego, vidrio, cripto) son
estimulantes. Son adictivas y causan alucinaciones,
insomnio y paranoia. EI comportamiento psicético o
violento y la depresién profunda también son efectos
graves de su uso prolongado.

El término “spice” (en espaiol, especias) (popurri,
incienso herbal, “K2”, “Zic Zac”, “Moon Rocks”) se
usa para describir una variedad de mezclas de
hierbas que se fuman con dosis de marihuana
sintética.
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no
son para nada seguros y también son ilegales si se
abusa de ellos. Los medicamentos de venta libre
incluyen remedios para la tos y el resfrio (Triple C,
Candy, Dex, DM, Drex, Red Devils, Robo, Rojo,
Skittles, Tussin, Velvet, vitamina D). Pueden causar
una variedad de sintomas, entre ellos, alucinaciones,
vomitos, presion arterial alta, convulsiones, dafio
cerebral y la muerte.

Los medicamentos recetados incluyen Oxycontin,
Vicodin, Xanax, Valium y Ritalin. Los médicos
pueden recetarlos para aliviar el dolor y relajar los
nervios y musculos. Cuando se toman en dosis
altas, o mezclados con alcohol, causan pérdida del
control corporal e incluso la muerte. Nunca tomes el
medicamento de otra persona y solo toma el tuyo en
la dosis correcta.

son muy
adictivos. Con el tiempo, el uso de la heroina
destruye tu cuerpo. Si compartes agujas al usarlos,
estas en riesgo de contraer VIH/SIDA.

es la llamada droga “para la violacién en citas” que
se disuelve rapidamente en las bebidas con gas.



Los esteroides se toman para ayudar a desarrollar
los musculos. Pero, al igual que el resto de las
drogas, presenta algunos efectos secundarios
bastante desagradables. Pueden provocar cambios
de humor y comportamiento agresivo, debilitar el
sistema inmunitario, desacelerar el crecimiento,
ademas de dafio hepatico y cancer. En los hombres,
pueden reducir el tamafio de los testiculos, hacer
bajar el recuento de espermatozoides y causar la
pérdida de cabello. En las mujeres, puede detener
los ciclos menstruales, causar pérdida del cabello
pero crecimiento del vello corporal y facial y agravar
la voz.
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Las siguientes paginas proporcionan informacion sobre los temas
que se abordaron en el presente folleto. Los nimeros de teléfono
estan a disposicion para usarlos en caso de que los necesites:

National Domestic Violence Hotline
(Linea Nacional sobre Violencia
Doméstica)

1-800-799-SAFE (7233)

National Runaway Switchboard (Central
Telefonica Nacional sobre Menores
Fugados)

1-800-RUNAWAY (786-2929)
www.1800runaway.org

National Child Abuse Hotline (Linea
internacional contra el maltrato infantil)
1-800-4-A-CHILD (422-4453)
www.childhelp.org

National Dating Abuse Helpline
(Linea Directa Nacional de Abuso en
Citas de Adolescentes)

Love is Respect

1-866-331-9474
www.loveisrespect.org



National Sexual Assault Hotline (Linea
de Atencion Nacional a Victimas de
Violencia Sexual)

1-800-656-HOPE (4673)
www.rainn.org

Seguridad en Internet
www.netsmartz.org/teens

Buenas practicas de alimentacion
www.choosemyplate.gov

National Suicide Prevention Lifeline (Red
Nacional de Prevencion del Suicidio)
1-800-273-TALK (8255)
www.suicidepreventionlifeline.org

Salud
www.kidshealth.org/teen
www.girlshealth.gov

Dejar de fumar
1-800-QuitNow (784-8669)

Salud sexual

www.iwannaknow.org

www.sexetc.org
www.pflag.org

Linea Directa sobre ETS
www.ashastd.org
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eenmeros de teléfono personales
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La informacién contenida en esta Guia de salud tiene fines educativos Unicamente. No
reemplaza la atencién ni el consejo médico. Siempre consulta a un médico u a otro proveedor de
servicios médicos en busca de asesoramiento sobre enfermedades y lesiones. No aceptamos
ninguna responsabilidad por los problemas que puedan suscitarse.
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